
РАЗРАБОТКА ПРИЛОЖЕНИЙ
НА БАЗЕ МК СЕМЕЙСТВА
AVR32

На момент написания этой статьи

автору было известно о двух програм�

мных инструментальных средствах

разработки/отладки приложений на

базе МК с архитектурой AVR32. Пер�

вое из них – программный пакет ин�

тегрированной среды разработки/от�

ладки (IDE) IAR Embedded Workbench®

for AVR32 от фирмы IAR. Альтернатив�

ным средством разработки/отладки

является пакет IDE AVR32Studio от

фирмы Atmel.

Помимо инструментальных средств

разработки/отладки, фирма Atmel сво�

бодно распространяет большое коли�

чество исходных текстов примеров, а

также программных драйверов узлов и

модулей МК AVR32. Указанная инфор�

мация для каждого семейства МК типа

AVR32 может быть бесплатно скачана с

сайта www.atmel.com в виде архивных

файлов AVR32�SoftwareFramework. В

этих архивах содержатся, в частности,

следующие компоненты:

● приложения и сервисы для МК се�

мейства AVR32 с примерами их ис�

пользования:

– библиотека AVR32 DSPLib, содер�

жащая набор цифровых функ�

ций обработки сигналов,

– файловая система FAT12/16/32,

– исходные коды ядра ОС free�

RTOS.org и пример демонстрацион�

ного приложения под freeRTOS.org,

– пример организации стека lwIP

TCP/IP для МК типа AT32UC3 с

контроллером MACB,

– рекомендации по организации

различных интерфейсов памяти (в

том числе, с файловой системой),

– пример построения устройства

USB CDC,

– пример использования USB�за�

грузчика для обновления встро�

енного программного обеспече�

ния с помощью внутрисистемно�

го программирования (ISP) МК,

– пример построения устройства

USB HID («мыши»),

– пример построения запоминаю�

щего устройства/хоста USB Mass

Storage,

– программные драйверы систем�

ных устройств и встроенной пе�

риферии МК типа AVR32 с приме�

рами их использования;

● программные драйверы внешних

устройств МК AVR32 с примерами

их использования:

– четырёхстрочный символьный

LCD�дисплей DIP204,

– манипулятор типа «джойстик»,

– микросхемы памяти архитекту�

ры Dataflash семейства AT45DB

производства Atmel,

– карты памяти SD/MMC,

– микросхемы памяти SDRAM фир�

мы Micron MT48LC16M16A2TG�7E

(с использованием интерфейса

внешней памяти EBI);

● командные файлы компоновщи�

ков и файлы макроопределений

для компиляторов IAR и GCC (по�

следний используется в AVR32Stu�

dio), а также заголовочные файлы

для всей встроенной периферии

семейства AVR32.

● заголовочные файлы для оценоч�

ных плат с МК типа AVR32 производ�

ства Atmel.

Исходные тексты и описание слож�

ного демонстрационного приложе�

ния «Панель управления» (Control

Panel) на базе оценочной платы

Atmel EVK1100, выполняющегося под

ОС freeRTOS.org. Приложение реали�

зует сбор данных с помощью встро�

енных средств оценочной платы и их

вывод через различные коммуника�

ционные интерфейсы, поддерживае�

мые МК; Control Panel использует

большинство вышеперечисленных

программных драйверов и сервисов.

Многие примеры и программные

драйверы из AVR32�SoftwareFrame�

work представлены исходными текс�

тами на языке C в двух вариантах: для

компиляторов IAR и GCC.

Пакет программ IDE Embedded

Workbench

Пакет IDE IAR Embedded Workbench

for AVR32 обеспечивает полную под�

держку всех МК семейств AP7000 и

UC3 с архитектурой AVR32. В пакет

IDE включены готовые файлы кон�

фигурации устройств и примеры

проектов для оценочных плат Atmel

EVK1100 и STK1000.

Поддержка IAR Embedded Workbench

эмулятора Atmel AVR32 JTAGICE�mkII

включает в себя поддержку трассиров�

ки режима NanoTrace, загрузчика

флэш�памяти, аппаратных и програ�

ммных точек останова. Поддержка IAR

Embedded Workbench RTOS для AVR32

включает поддержку интерфейса

OSEK Run Time Interface (ORTI).

Файл дистрибутива пакета IDE IAR

Embedded Workbench for AVR32 до�

ступен для бесплатного скачивания

на сайте производителя www.iar.com

в двух демонстрационных версиях: с

ограниченным объёмом выходного

бинарного файла (32 Кб), но без

ограничения времени использова�

ния, и без ограничения объёма кода,

но с ограниченным временем ис�

пользования (30 дней).

Пакет включает в себя набор инст�

рументальных средств, которые ин�

тегрированы в единую программную

оболочку с удобным оконным интер�

фейсом, работающую под ОС Win�

dows Microsoft. Пакет IAR Embedded

Workbench for AVR32 состоит из сле�

дующих компонентов:

● собственно IDE (текстовый редак�

тор, менеджер проектов и т.д.);
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● компилятора IAR C/C++;

● ассемблера IAR;

● универсального компоновщика

IAR XLINK Linker;

● программы построения библиотек

IAR XAR Library Builder;

● набора библиотек IAR XLIB Libra�

rian;

● отладчика IAR C�SPY Debugger с си�

мулятором;

● файлов конфигурации для всех

устройств AVR32;

● контекстно�зависимой интерак�

тивной справки.

Работа пользователя с пакетом IDE

IAR Embedded Workbench во многом

схожа с работой с пакетом IDE IAR

Embedded Workbench ARM (IAR

EWARM) [4]. Для получения информа�

ции по IAR Embedded Workbench ре�

комендуется обратиться к [5].

Разработка приложения в IDE на�

чинается с создания нового проекта.

Перед созданием проекта пользова�

тель должен создать (или использо�

вать созданную по умолчанию) в IDE

рабочую область. При создании про�

екта пользователь последовательно

задаёт его имя, тип, параметры и

функции (тип МК целевой системы и

аппаратной платформы, конфигура�

цию компоновки и т.д.). В процессе

работы с проектом к нему можно до�

бавлять различные файлы (исход�

ные, заголовочные, подключаемые и

т.п.). Затем созданный проект подвер�

гается компиляции и компоновке.

При этом создаётся файл листинга

компилятора, файл карты компонов�

щика, а также другие выходные фай�

лы, тип и наличие которых определя�

ется заданными для проекта настрой�

ками компоновщика.

После успешного завершения ком�

пиляции и компоновки проект мо�

жет быть отлажен. Встроенный в IDE

высокоуровневый отладчик IAR C�SPY
Debugger обеспечивает возможность

одновременной разработки и отлад�

ки приложения. Наиболее простой

способ отладки заключается в ис�

пользовании программного драйве�

ра симулятора C�SPY Debugger. Симу�

лятор программно моделирует все

функции объектного процессора,

что позволяет отладить приложение

до его записи в целевую систему. По�

скольку никакие аппаратные сред�

ства при этом не требуются, указан�

ный способ отладки является самым

рентабельным решением для многих

приложений. Симулятор C�SPY De�
bugger может имитировать прерыва�

ния ЦПУ, а также периферийные уст�

ройства (с использованием системы

макрокоманд C�SPY). Симулятор так�

же позволяет моделировать трасси�

ровку, проверять корректность досту�

па к памяти, использовать точки

останова, а также производить мони�

торинг памяти и регистров МК.

Отладчик C�SPY Debugger наряду с

отладкой в режиме симуляции мо�

жет быть использован для отладки

непосредственно в «железе», т.е. в

составе целевой системы [6]. Отлад�

ка в целевой системе осуществляет�

ся с помощью аппаратного драйве�

ра (кабеля), обеспечивающего фи�

зическую связь с целевой системой.

Используемая автором версия IAR

Embedded Workbench поддерживает

только один тип аппаратного драй�

вера C�SPY Debugger – JTAGICE�mkII
производства Atmel. Кабель JTAG�

ICE�mkII подключается к МК целе�

вой системы через встроенный ин�

терфейс JTAG, как показано на

структурной схеме, изображённой

на рисунке 14.
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В начале сеанса отладки пользова�

тельское приложение по умолчанию

автоматически загружается во флэш�

память МК, однако в случае необхо�

димости эта процедура может быть

отменена. Перед запуском сеанса от�

ладки в целевой системе необходимо

задать в проекте установки, касаю�

щиеся отладки. В частности, эти уста�

новки определяют выбор драйвера

на странице Setup категории De�
bugger (следует выбрать JTAGICE mkII),

а также выбор параметров управле�

ния загрузкой на странице Setup кате�

гории JTAGICE mkII, показанной на

рисунке 15.

Как и в случае программной симу�

ляции, отладчик C�SPY обеспечивает

возможность трассировки приложе�

ния в целевой системе. Данные трас�

сировки при этом будут поступать в

хост�компьютер через JTAGICE�mkII и

отображаться в окне трассировки,

как показано на рисунке 16.

При отладке в целевой системе

C�SPY позволяет установить в про�

грамме до шести аппаратных точек

останова или неограниченное коли�

чество программных точек останова

(параметр Enable software break�
points на странице Setup категории

JTAGICE mkII). Точки останова дан�

ных при отладке в целевой системе

недоступны.

Пакет программ IDE AVR32Studio

Программный пакет IDE AVR32Stu�

dio 2.0, который использовал автор,

поддерживает разработку автоном�

ных (без ОС) приложений для всех

устройств семейств AT32AP7000 и

AT32UC3, а также приложений под

ОС Linux для устройств AT32AP7000.

Пакет AVR32Studio также поддержи�

вает все инструментальные средства

производства Atmel, разработанные

для поддержки архитектуры AVR32,

включая JTAG�адаптеры JTAGICE�mkII

и AVR ONE!, а также отладочные

платы EVK1100, EVK1101, NGW100,

STK1000, STK1002 и STK600.

Пакет IDE AVR32Studio содержит за�

конченный набор компонентов, в

число которых входят:

● менеджер проектов с конкурент�

ной системой версий (CVS);

● редактор языка C/C++ с поддерж�

кой выделения синтаксиса и завер�

шённого кода;

● отладчик, поддерживающий управ�

ление пошаговым выполнением на

уровне команд исходного кода, а

также точки останова;

● средства мониторинга регистров, па�

мяти и подсистем ввода�вывода МК;

● средства конфигурирования и управ�

ления целевой системой.

Как можно видеть из этого перечня,

собственного компилятора C в сос�
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Рис. 16. Разработка проекта в IDE IAR Embedded Workbench for AVR32

Рис. 15. Выбор опций управления загрузкой

Рис. 14. Блок�схема подключения

JTAGICE�mkII к МК целевой системы



таве AVR32Studio нет. Поэтому для

формирования и отладки проектов

AVR32Studio использует дополнитель�

ные программные инструментальные

средства из пакета AVR32 GNU Tool�

chain (компилятор, набор необходи�

мых вспомогательных программ и

библиотек). Компилятор GNU C (GCC)

используется в AVR32Studio для ком�

пиляции программ C/C++, а отладчик

GNU (GDB) – для отладки приложе�

ния в целевой системе.

Таким образом, для обеспечения

возможности подготовки в AVR32Stu�

dio исходных кодов на языке C/C++, на

хост�компьютер необходимо устано�

вить не только дистрибутив IDE

AVR32Studio (файл AVR32Studio�2.x.x�

Setup.exe), но и дистрибутив AVR32

GNU Toolchain (файл avr32�gnu�tool�

chain�2.x.x.exe). Оба этих файла до�

ступны для бесплатного скачивания

на интернет�странице www.atmel.com.

Пакет AVR32Studio предлагается для

скачивания в двух версиях: под ОС

Linux и под ОС Windows.

Подобно пакету IDE IAR Embedded

Workbench, при работе в пакете IDE

AVR32Studio используется понятие

рабочая область. Каждая рабочая об�

ласть содержит одну или более пер�
спектив. Перспективы, в свою оче�

редь, содержат обозрения и редакто�
ры, доступ к которым возможен через

соответствующие меню и инструмен�

тальные панели. На рабочем столе

одновременно может существовать

несколько окон рабочей области.

Перспектива определяет начальный

набор и размещение обозрений в ок�

не рабочей области. В пределах окна

каждая перспектива совместно ис�

пользует один и тот же набор редакто�

ров. Каждая перспектива предоставля�

ет пользователю набор функциональ�

ных возможностей, нацеленных на

выполнение определённого типа за�

дач, или работает с определёнными

типами ресурсов. Например, перспек�

тива C/C++ объединяет обозрения, ко�

торые обычно используются при ре�

дактировании исходных файлов, а

перспектива Debug содержит обозре�

ния, которые используются при от�

ладке программ. При работе с различ�

ными проектами в рабочей области

пользователь может производить пе�

реключение перспектив.

Перспективы могут содержать

собственные меню и инструменталь�

ные панели. Они определяют видимые

наборы действий, которые пользова�

тель может задействовать, чтобы наст�

роить перспективу. Для открытия тре�

буемой перспективы в окне рабочей

области следует выбрать в главном ме�

ню Window > Open Perspective. Чтобы

увидеть список всех поддерживаемых

перспектив, следует выбрать Window >

Open Perspective > Other..., после чего

откроется окно Open Perspective, как

показано на рисунке 17.
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Обозрения поддерживают редак�

торы и обеспечивают альтернатив�

ные представления, а также способы

управления информацией в рабочих

областях. Например, проводник про�

ектов (Project Explorer) и другие нави�

гационные обозрения управляют

отображением проектов и других ре�

сурсов, с которыми работает пользо�

ватель. Обозрения также имеют свои

собственные меню. Чтобы сделать

это меню видимым, следует кликнуть

кнопкой мыши на иконке в левой

части области заголовка обозрения.

Некоторые обозрения также имеют

свои собственные инструменталь�

ные панели.

Вид окна рабочей области AVR32Stu�

dio показан на рисунке 18. По умол�

чанию в нём открывается перспек�

тива AVR32 C/C++, в которой, в свою

очередь, открыты окна нескольких

обозрений; каждое окно обозрения

содержит собственную инструмен�

тальную панель и набор окон, по

умолчанию расположенных в виде

«стека».

Первое, что следует сделать в начале

разработки приложения AVR32, – соз�

дать новый проект. Для этого в меню

File окна рабочей области следует

выбрать пункт New..., а затем выбрать

тип создаваемого проекта, как показа�

но на рисунке 19. Если выбрать один

из явно предлагаемых в меню типов,

то по умолчанию будет создан проект

вида Managed make, который не пре�

дусматривает самостоятельное управ�

ление со стороны пользователя make�

файлом проекта. При этом откроется

окно создания нового проекта, в кото�

ром необходимо заполнить поля на�

звания проекта, типа платформы (МК

семейства AVR32) и типа проекта.

Возможно создание нового проек�

та на языке C/C++ «с нуля» (AVR32
C Project) на базе одного из имею�

щихся в AVR32Studio шаблонов

(AVR32 C Project from a template), а

также на базе одного из имеющихся

в AVR32Studio примеров (Project... >

Examples). При выборе примера ав�

томатически производится и выбор

аппаратной платформы, поскольку

каждый из предлагаемых примеров

сопоставлен в списке конкретной

платформе – отладочной плате про�

изводства Atmel. После создания но�

вого проекта на жёстком диске

компьютера будет создан каталог с

выбранным именем проекта. В этот

каталог можно помещать исходные

файлы проекта и открывать их в ок�

не редактора AVR32Studio, выбирая в

меню File > Open File и используя со�

ответствующие перспективы. Как

уже упоминалось, пакет AVR32Studio

обеспечивает поддержку редактиро�

вания кода, написанного на C/C++.

Каждый вновь создаваемый проект

должен быть сформирован (скомпоно�

ван). Система управления формирова�

нием AVR32Studio имеет два операци�

онных режима: внутреннее (непосред�

ственное) формирование (Internal
build) и управление формированием

(Managed make). Режим Managed make

автоматически создаёт make�файл для

формируемого проекта, используя за�

даваемые пользователем параметры

настройки формирования. Указанный

режим является наиболее типичным и

задаётся по умолчанию.

Создание проекта с непосредствен�

ным формированием производится

путём выбора в меню File > New... >

Project. . . с последующим выбором

нужного мастера проекта, как показа�

но на рисунке 20.

Формирование запускается выбо�

ром в меню Project > Build Project или

нажатием на клавиши Ctrl+B, когда

файл проекта открыт в окне редакто�

ра. Результаты формирования можно

видеть в окнах Console и Problems
обозрения перспективы Debug.

Для задания в проекте целевой сис�

темы необходимо выбрать в меню ок�

на рабочей области Window > Show
view > (Other… > AVR32 Development) >

AVR32 Targets, после чего откроется

окно целевых систем AVR32 Targets
(см. рис. 18). Кликнув в нём правой

кнопкой мыши, следует запустить

функцию Scan Targets из контекстно�

го меню. Предварительно JTAG�адап�

тер и отладочная плата должны быть

подключены к компьютеру. Когда па�

кет AVR32Studio обнаружит подклю�

ченную к компьютеру целевую систе�

му, информация о ней отобразится в

окне AVR32 Targets. В случае отсут�

ствия подключенной целевой систе�

мы AVR32Studio считает таковой

программный симулятор, информа�

цию о котором отображает в окне,

как показано на рисунке 18. Пользо�

ватель может также вручную доба�

вить в список новую целевую систему

(New Target), кликнув на кнопке Crea�
tes a new target в меню окна AVR32
Targets. Свойства (компоненты) целе�

вой системы из списка можно прос�

мотреть и отредактировать, поместив

на её позицию в окне курсор и нажав

на клавишу Enter.

В зависимости от конфигурации

имеющейся целевой системы, пакет

AVR32Studio поддерживает выполне�

ние с ней различных операций (за�

пись, чтение, верификация, стирание

и т.д.). Все доступные для целевой

системы операции отображаются в

её контекстном меню, которое акти�

визируется кликом правой кнопкой

мыши на позиции целевой системы в

окне AVR32 Targets.

Поддерживаемые пакетом AVR32Stu�

dio возможности по конфигурирова�

нию запуска позволяют задавать па�

раметры запуска отладки (Debug) или

параметры запуска выполнения
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Рис. 18. Вид окна рабочей области AVR32Studio



(Run) программы. Запуск отладки мо�

жет использоваться для подключения

отладчика GDB к целевой системе и

осуществления трассировки, в то вре�

мя как запуск выполнения иницииру�

ет простое выполнение бинарного

файла «прошивки» в МК целевой сис�

темы. Диалоговое окно задания пара�

метров запуска отладки открывается

при выборе в главном меню Run >

Open Debug Dialog... (см. рис. 21), а ди�

алоговое окно задания параметров

запуска выполнения – Run > Open Run
Dialog...

Конфигурация запуска отладки/вы�

полнения включает в себя четыре раз�

дела:

● главную конфигурацию;

● конфигурацию отладчика;

● конфигурацию трассировки;

● общую конфигурацию.

Каждому из этих разделов в диало�

говом окне посвящена отдельная

страница. Чтобы эти страницы стали

доступными, необходимо сначала за�

дать приложение для отладки/выпол�

нения. Для этого следует выбрать кур�

сором тип приложения в левой части

окна, как показано на рисунке 21, а

затем кликнуть на иконке New launch

configuration инструментальной па�

нели окна. При этом создаётся новая

конфигурация запуска отладки/вы�

полнения, для которой откроются

страницы конфигурации, как показа�

но на рисунке 22.

Первая страница в диалоге конфи�

гурации запуска Maim содержит глав�

ные параметры настройки. Здесь

пользователь должен определить

конфигурацию запуска для проекта,

тип двоичного файла, который дол�

жен быть загружен в целевую систе�

му, а также используемый проводник

запуска.

Страница конфигурации отладчи�

ка Debugger содержит параметры

настройки отладчика.

Страница общей конфигурации Com�
mon используется для задания общих

параметров конфигурации запуска.

Страница конфигурации трасси�

ровки Trace содержит параметры

настройки трассировки. Чтобы разре�

шить трассировку, пользователь дол�

жен включить параметр Enable trace.

КОМПОНЕНТЫ

Рис. 19. Выбор типа создаваемого проекта

Рис. 20. Создание проекта

с непосредственным формированием



Кроме того, необходимо выбрать ис�

пользуемый метод трассировки из

двух имеющихся: NanoTrace и Auxiliary
Trace. Запуск трассировки произво�

дится из обозрения трассировки или

посредством задания точки трасси�

ровки, как будет показано ниже.

Под точками трассировки (trace�

points) понимается адрес в памяти

или глобальная переменная в исход�

ном файле, при осуществлении за�

данного типа доступа к которым про�

исходит заданное событие, связан�

ное с трассировкой: старт/стоп

трассировки или генерация сообще�

ния трассировки.

Точки трассировки могут быть

установлены в двух различных обо�

зрениях. При редактировании кода в

редакторе C/C++ пользователь может

добавить строку точки трассировки,

нажав на нужной строке кода

Ctrl+Alt+T. При этом откроется окно

настроек, содержащее меню наст�

ройки Tracepoint. Та же самая опера�

ция будет выполнена, если в обозре�

нии Disassembly ввести адрес точки

трассировки. Строка исходного тес�

та, на которой создана точка трасси�

ровки, будет подсвечиваться в окне

редактора. Нажатие Ctrl+Alt+T на

строке, где уже существует точка

трассировки, приведёт к её удалению.

Поле Tracepoint type в меню Trace�
point используется для задания вида

трассировки. Как трассировка дан�

ных, так и трассировка программы

могут быть запущены триггером

трассировки. Когда задана трасси�

ровка данных, пользователь может

также задать, какая область памяти

подлежит трассировке. Поле Trace

operation используется для задания

операции трассировки, автоматичес�

ки выполняемой при срабатывании

точки трассировки.

Для открытия обозрения регист�

ров МК целевой системы необходи�

мо выбрать в меню Window > Show
view > (Other…) > AVR32 Registers, по�

сле чего откроется окно AVR32 Regis�

ters (см. рис. 18). Обозрение регист�

ров позволяет производить монито�

ринг всех регистров и битовых по�

лей из области, используемой в ак�

тивном проекте или принадлежащей

текущему сеансу отладки. Помимо

мониторинга, возможно также ре�

дактирование содержимого регист�

ров. Выбрав курсором позицию нуж�

ного регистра, можно редактировать

содержимое его битов. Двойной клик

на позиции регистра в дереве его

отображения или нажатие клавиши

Enter приведёт к вызову редактора.

Значения отображаемых регистров

будут изменяться всякий раз при

приостановке ЦПУ.

АППАРАТНЫЕ
ИНСТРУМЕНТАЛЬНЫЕ
СРЕДСТВА

Для разработки/отладки/програм�

мирования приложений на базе МК с

архитектурой AVR32 фирма Atmel пред�

лагает ряд аппаратных инструменталь�

ных средств собственного производ�

ства. Это, прежде всего, JTAG�адаптеры

JTAGICE�mkII и AVR ONE!, а также от�

ладочные платы EVK1100, EVK1101,

NGW100, STK1000, STK1002 и STK600.

Наиболее мощным и функциональ�

но полным аппаратным отладочным

средством для МК семейства AVR32

является адаптер AVR ONE!. Он под�

держивает отладку на кристалле, ISP�

программирование, а также Nexus

AUX�трассировку всех выпускаемых

в настоящее время МК типа AVR32, и

совместим с пакетом программ IDE

AVR32Studio. Версия программной

прошивки AVR ONE! 1.1, предлагае�

мая производителем на момент на�

писания этой статьи, поддерживает

отладку (программирование) только
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Рис. 23. Комплект адаптера AVR ONE!

Рис. 24. Комплект адаптера JTAGICE�mkII

Рис. 25. Отладочная плата EVK1100

Рис. 21. Диалоговое окно задания опций запуска отладки Рис. 22. Страницы конфигурации отладки/выполнения приложения



через два интерфейса МК AVR32: JTAG

и Nexus 2.0 (IEEE�ISTO 5001�2003).

Необходимо отметить, что адаптер

AVR ONE! не является эмулятором.

Принцип его работы основан на ин�

терфейсе со встроенной системой от�

ладки (OCD) МК целевой системы, что

и обеспечивает механизм контроля

выполнения пользовательского кода.

В режиме выполнения кода ЦПУ этот

процесс полностью независим от

адаптера. Однако AVR ONE! при этом

непрерывно контролирует МК целе�

вой системы, чтобы отслеживать, не

произошло ли условие останова. Ког�

да это условие наступает, система OCD

опрашивает ЦПУ микроконтроллера

через его интерфейс отладки, что даёт

возможность хост�компьютеру полу�

чить через адаптер информацию о те�

кущем состоянии МК. Адаптер AVR

ONE! поддерживает как программные,

так и аппаратные точки останова.

Внешний вид комплекта адаптера

AVR ONE! показан на рисунке 23.

Адаптер подключается к хост�компь�

ютеру через порт USB. К недостаткам

адаптера AVR ONE! можно отнести

его высокую стоимость.

Адаптер JTAG типа JTAGICE�mkII

представляет собой более простое и

доступное средство отладки. Он сов�

местим как с пакетом IDE AVR32Studio,

так и с пакетом IDE AVRStudio версии

4.09 и выше. Адаптер JTAGICE�mkII

поддерживает отладку и ISP�програм�

мирование всех МК семейства AVR32,

а также всех МК с архитектурой AVR

(имеющих JTAG), но только через ин�

терфейс JTAG, совместимый со стан�

дартом IEEE 1149.1. Помимо этого,

адаптер поддерживает отладку и ISP�

программирование всех МК, имею�

щих интерфейс debugWIRE.

По принципу функционирования

адаптер JTAGICE�mkII может быть от�

несён к традиционным эмуляторам.

Он использует интерфейс JTAG для

организации эмуляции реального

времени в МК целевой системы, в то

время как в МК выполняется пользо�

вательский код. Протокол AVR�отлад�

ки на кристалле (AVROCD) предо�

ставляет пользователю законченную

систему управления внутренними ре�

сурсами МК. Однако при этом адап�

тер JTAGICE�mkII поддерживает толь�

ко программные точки останова.

Адаптер JTAGICE�mkII может быть

подключен к хост�компьютеру через

COM�порт (поддерживает специфика�

цию RS�232) или через порт USB (под�

держивает спецификацию USB 1.1). В

последнем случае возможно питание

адаптера от хост�компьютера. Внеш�

ний вид комплекта адаптера JTAGICE�

mkII показан на рисунке 24. Для свое�

го питания адаптер JTAGICE mkII мо�

жет использовать внешний источник

или шину USB, но не источник целе�

вой системы. По умолчанию выбира�

ется внешнее электропитание.

Для построения приложений на базе

МК семейства AT32UC3 фирма Atmel

предлагает отладочные платы

EVK1100 и EVK1101. Внешний вид

платы EVK1100 показан на рисунке 25.

Помимо МК типа AT32UC3A0512 (в

корпусе QFP144) плата содержит сле�

дующие элементы аппаратной «обвяз�

ки»: микросхему памяти SPI Dataflash

AT35DB642 ёмкостью 8 Мбит, мик�

росхему SDRAM MT48LC16M16A2

ёмкостью 32 Мбит, символьный четы�

рёхстрочный ЖКИ типа EA�DIP204B�

4NLW, датчики освещённости, темпе�

ратуры и аналоговый потенциометр,

подключенные к входам модуля АЦП

микроконтроллера; три кнопки, мани�

пулятор типа «джойстик», подключен�

ный к входам сканирования внешней

клавиатуры МК; шесть светодиодов,

три подключенных к МК кварцевых ре�

зонатора (12 МГц, 12 МГц и 32 768 Гц).

Интерфейсы МК выведены через соот�

ветствующие разъёмы: два девятивы�

водных RS�232, mini A�B USB, RJ45

Ethernet, слот SD/MMC (SPI), JTAG,

NEXUS, шину EBI, порты ввода�вывода

общего назначения и т.д. Имеющиеся

на плате стабилизаторы напряжения

позволяют осуществлять её питание от

шины USB или от внешнего источника

постоянного напряжения 8…20 В.

Отладочная плата EVK1101 содер�

жит МК типа AT32UC3B0256 (в корпу�

се LQFP64) и несколько сокращён�

ный по сравнению с EVK1100 набор

аппаратной «обвязки». Отладочные

платы NGW100, STK1000 и STK1002

построены на базе МК семейства

AT32AP7000.
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